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ΕΙΣΑΓΩΓΗ 

 

Στο  παρών δοκίμιο, περιγράφεται μοντέλο σύνθετης ανάλυσης ή αλλιώς «Composite Analysis 

Model» (CAM) στο πρόγραμμα SCIA Engineer. Το CAM χρησιμοποιείται στο SCIA Engineer για 

την ανάλυση και το σχεδιασμό σύνθετων δοκών που περιλαμβάνουν:  

 

• χάλυβα βαρέων διαστάσεων 

• οπλισμένο σκυρόδεμα 

• συνδέσεις διάτμησης μεταξύ δοκού χάλυβα (steel beam) και πλάκα (deck) 

• κυματοειδές φύλλο από χάλυβα που χρησιμεύει επίσης ως ξυλότυπος για το υγρό 

σκυρόδεμα κατά τη διάρκεια των σταδίων κατασκευής.  

Το CAM είναι μια γενική μέθοδος μοντελοποίησης και αριθμητικής ανάλυσης που αποσκοπεί στην 

ακριβή ανάλυση της συμπεριφοράς των σύνθετων δομών χάλυβα-σκυροδέματος (steel-concrete 

composite structures). Δεδομένου ότι το CAM βασίζεται σε τυποποιημένα εργαλεία 3D 

μοντελοποίησης του SCIA Engineer, δεν υπάρχουν περιορισμοί σχετικά με τη γεωμετρία της 

δομής. Επί του παρόντος, κάθε δομή που περιέχει σύνθετα δάπεδα μπορεί να αναλυθεί 

χρησιμοποιώντας (κτίρια, γέφυρες, βιομηχανικές κατασκευές, κλπ.). Το CAM παρέχει 

παραμορφώσεις και εσωτερικές δυνάμεις (deflections and internal forces) που μπορούν να 

χρησιμοποιηθούν σε σύνθετη δομή δέσμης (composite beam design ) βασισμένη στους ελέγχους 

κώδικα σχεδιασμού (design code checks). 

 

Για την ανάλυση σύνθετων δαπέδων (Composite floors) χρησιμοποιείται σύνθετο (ή μεταλλικό) 

κατάστρωμα (Composite deck) το οποίο μπορεί να μοντελοποιηθεί είτε ως διάφραγμα είτε ως 

πρότυπο μέλος FEM 2D. 

 

Στην περίπτωση ενός διαφράγματος, όλα τα φορτία ανακατανέμονται στις δοκούς του δαπέδου 

(beams of the floor) χρησιμοποιώντας την ίδια τεχνική με τις πλάκες φόρτωσης (load panels). Για 

τους δοκούς, το πρόγραμμα προσθέτει αυτόματα τη συνεισφορά του συμμετέχοντος πλάτους του 

πλάκα (deck) στη διατομή χάλυβα που ορίζεται από τον χρήστη, με βάση τις ιδιότητες του 

καταστρώματος. Το πραγματικό πλάτος μπορεί να υπολογιστεί αυτόματα ή να οριστεί από τον 

χρήστη του προγράμματος. 

 

Η άλλη επιλογή είναι η χρήση μιας τυποποιημένης πλάκας FEM για τη μοντελοποίηση της πλάκα 

(deck). Ουσιαστικά, ένα σύνθετο κατάστρωμα με δοκούς (composite deck with beams) 

μοντελοποιείται ως πλάκα με εκκεντρικές νευρώσεις (eccentric ribs).  

 

Η πλάκα αντιπροσωπεύει το σύνθετο κατάστρωμα, το οποίο είναι από μόνο του ένα σύνθετο 

δομικό στοιχείο κατασκευασμένο από ένα προφίλ από χάλυβα με οπλισμένο σκυρόδεμα. Οι 

χαλύβδινες δοκοί εκπροσωπούνται από έκκεντρα ή μη έκκεντρα μέλη 1D, δηλαδή νευρώσεις 

πλάκας, συνδεδεμένα με την πλάκα.  
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Αυτό παρουσιάζει αρκετά πλεονεκτήματα σε σύγκριση με τις πιο παραδοσιακές προσεγγίσεις 

όπου η δομή στήριξης διαμορφώνεται ως πλέγμα δοκού. 

Αρχικά, δεν απαιτούνται ‘’Load panels’’ για τη διανομή φορτίων στις δοκούς. Επίσης, δεν 

χρειάζονται απλουστευμένες παραδοχές σχετικά με την κατανομή του φορτίου (load distribution). 

Ακολούθως, η ακαμψία στο επίπεδο της πλάκας (deck) υπολογίζεται αυτόματα και λαμβάνεται 

υπόψη, καθώς η πλάκα διαμορφώνεται ως δομικό μέλος δεν απαιτούνται πρόσθετες 

απλουστευτικές παραδοχές στην περίπτωση οριζόντιας φόρτωσης της δομής. 

 

Ανεξάρτητα πια μέθοδο θα ακολουθήσει ο Πολιτικός Μηχανικός, η CAM λαμβάνει υπόψη τις τρεις 

κύριες φάσεις κατασκευής για το σχεδιασμό σύνθετων δομών (composite structures): 

 

1. Το στάδιο κατασκευής, κατά το οποίο οι δοκοί (beams) και τα φύλλα χάλυβα (steel 

sheeting) φέρουν μόνο το νωπό σκυρόδεμα (wet concrete) και απορροφούν τυχόν 

εφαρμοζόμενα φορτία. To self-weight του προσφάτως χυτευμένου σκυροδέματος 

υπολογίζεται και λαμβάνεται άμεσα υπόψη ως μέρος του self-weight βάρους της 

κατασκευής. 

 
2. Tο τελικό στάδιο για μακροπρόθεσμες ενέργειες, όπου λαμβάνεται υπόψη το σύνθετο 

αποτέλεσμα · η επίδραση της ολίσθησης λαμβάνεται υπόψη από τη μειωμένη ακαμψία 

των τμημάτων του σκυροδέματος αλλά και το τελικό στάδιο για βραχυπρόθεσμες 

ενέργειες, όπου το σύνθετο αποτέλεσμα λαμβάνεται υπόψη με την ονομαστική 

ακαμψία του σκυροδέματος. 

 
3. Η επίδραση από το φαινόμενο του ερπυσμού (effect of creep) μπορεί να είναι 

προαιρετικά απενεργοποιημένη. Μια ρύθμιση επιτρέπει επίσης όλα τα σύνθετα 

τμήματα να θεωρηθούν ότι στηρίζονται στο στάδιο της κατασκευής. 
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Έννοιες που χρησιμοποιούνται στο παρόν βοήθημα. 

 

Deck: είναι η πλάκα η οποία τα φορτία που παραλαμβάνει τα μεταφέρει στις δοκούς.  
 

Σύνθετα καταστρώματα (Composite deck) και μεταλλικά καταστρώματα (metal deck).  
 

• Ένα σύνθετο κατάστρωμα (Composite deck ) έχει δύο στρώσεις: ένα προφίλ από 

χάλυβα και ένα στρώμα από σκυρόδεμα, οπλισμένο ή μη οπλισμένο. Ένα σύνθετο 

κατάστρωμα διαμορφώνεται ως πολυστρωματική πλάκα (multi-layered plate). Κάθε 

στρώμα έχει ορθοτροπικές ιδιότητες (orthotropic properties) και λαμβάνεται υπόψη η 

εκκεντρότητα (eccentricity) κάθε στρώματος. Η αλληλεπίδραση των στρωμάτων 

θεωρείται ως ένας τέλειος δεσμός, δηλ. Χωρίς οιαδήποτε ολίσθηση μεταξύ των 

στρωμάτων (σκυρόδεμα και χαλύβδινο φύλλο). Τα στελέχη προσδιορίζονται από τις 

μετατοπίσεις και τις περιστροφές στους κόμβους του πλέγματος πεπερασμένων 

στοιχείων. 

 
 

• Ένα μεταλλικό κατάστρωμα (metal deck) έχει μόνο ένα στρώμα, δηλ. το φύλλο χάλυβα, 

και χρησιμοποιείται κυρίως για ελαφρές στέγες. 
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Το κατάστρωμα ως διάφραγμα και δοκοί με μετασχηματισμένη σύνθετη διατομή (Deck as a 

diaphragm and beams with transformed composite cross-section). 

 

• Οι σύμμεικτες πλάκες (composite decks) ρυθμίζονται από προεπιλογή ώστε να 

αναλύονται ως άκαμπτα διαφράγματα (rigid diaphragms). Τα χαλυβδόφυλλα (metal 

decks) ορίζονται από προεπιλογή για να αναλυθούν ως εύκαμπτα διαφράγματα 

(flexible diaphragms). Οι σύνθετες δοκοί (composite beams) ορίζονται από προεπιλογή 

για ανάλυση με την τυποποιημένη σύνθετη δράση - δηλ. Με τη μέθοδο 

μετασχηματισμένης διατομής (cross-section method). 

Χαλυβδόφυλλα ως πλάκα FEM και δοκοί με μετασχηματισμένη σύνθετη διατομή (Deck as 
standard FEM plate and beams with transformed composite cross-section) 

 

• Αυτή η τεχνική χρησιμοποιεί μετασχηματισμένες διατομές για σύνθετες δοκούς, με 

παρόμοιο τρόπο όπως και η προηγούμενη προσέγγιση. Ωστόσο, η πραγματική 

δυσκαμψία του χαλυβδόφυλλου (πλάκας-deck) λαμβάνεται υπόψη στο μοντέλο 

ανάλυσης, το οποίο επιτρέπει να ληφθούν υπόψη οι αλληλεπιδράσεις στο σύστημα 

που οφείλονται στη συμβολή της σύμμεικτης πλάκας (contribution of the deck). 

Συνιστάται για το σχεδιασμό πολύπλοκων σύνθετων δαπέδων (complex composite 

floors), ειδικά όταν οι παρατυπίες στο σύστημα υποστήριξης ενδέχεται να 

προκαλέσουν ασυνήθιστες αλληλεπιδράσεις και ανακατανομή εσωτερικών δυνάμεων 

μεταξύ δοκών μέσω του καταστρώματος. Με το SCIA Engineer, αυτή η προσέγγιση 

μπορεί να επιτευχθεί θέτοντας τη συμπεριφορά του στοιχείου ενός σύνθετου / 

μεταλλικού χαλυβδόφυλλου σε ‘’Standard FEM’’ (Element behaviour of a composite / 

metal deck to ‘’Standard FEM’’). Οι σύνθετες δοκοί πρέπει να χρησιμοποιούν την 

τυποποιημένη σύνθετη ενέργεια (Standard composite action).  

 

 

Για περισσότερα, όσο αφορά το “Composite structure” δείτε: 

 

• Composite Analysis Model - Theoretical background 

• Composite Beam  

mailto:info@masesoft.com
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PROCESS FOR CALCULATION 

 

1. New Project 

File → New or Blank Project 

 

2. Project data 

Project data → Basic data → Material (Concrete, Steel for composite action) 
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2.1. Functionality  

 

1η Στήλη 2η Στήλη 

Climatic loads   √ Dynamics 
- Seismic spectral analysis   √ 

Dynamics   √ 

 

Subsoil 

- Pad foundation   √ 

- Soil Interaction √ 

Stability √ Steel 

-Steel connections   √ 

Structural model   √  
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2.2. Actions 

Loads → Wind load (according to code – για Κύπρο CY 24 m/sec – 40 m/sec – usually 30 m/sec) 

→ Snow load (according to code) 

→ Model factor - 1.30 

→ Seismic Combinations → Factor for concomitant components - 0.3 

→ OK! 

In case if being not sure how to create the combinations at the ‘’Code Combinations’’ 

choose ‘’Automatic’’ option. 
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3. Κάνναβος 

 
Main → Line grid and storeys → 3D line grid  
Span Dr (X), Span Dr (Y)  Dr (Z)  → OK 
 
At the command window write ‘’0’’ to add it on the 0,0,0 UCS → Enter 
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➔ Τοποθετούμε τον κάνναβο στο X,Y,Z 

➔ Για να κρύψω προσωρινά τον κάνναβο :   

 

 
 

 

Intro to View Parameters, Units & Member Properties 

 

• https://www.youtube.com/watch?v=rUfvER8TQrM&index=10&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 
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3.1. Import CAD files: 

Main → Structure → Modelling / Drawings → Import DWG, DXF, VRML97. 
 

 
 

 

Import CAD Files 

 

• https://www.youtube.com/watch?v=Znp1-

OV7cOo&index=11&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Import IFC 

 

• https://www.youtube.com/watch?v=Wwa3TlAf9K4&index=12&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 
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3.2. Snap Settings 

 

 
 

 

Cursor Snap Settings 

 

• https://www.youtube.com/watch?v=WbH_KtSsD14&index=9&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 
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4. Layers 

➔ Για όλες τις διατομές και πλάκες ανά όροφο. 

 

 
 

 
 

Ta ‘’Layers’’ προσφέρονται για να 

μπορείτε να έχετε καλύτερο 

έλεγχο της κατασκευής σας. 

Επίσης, χρησιμεύει στην 

αυτόματη διαστασιολόγηση 

(Autodesign) γιατί μπορώ εύκολα 

να φιλτράρω τα μέλη μου μέσω 

των ‘’Layers’’. 

Η επιλογή ‘’Structural model only’’ 

σημαίνει ότι, τα μέλη σας που 

βρίσκονται σε αυτό/α τα ‘’Layer’’ 

που έχει αυτή την επιλογή, το 

SCIA Engineer δεν θα σας κάνει 

την ανάλυση του/των 

συγκεκριμένων μελών. 

 

Μόλις όμως προχωρήσετε σε 

ανάλυση θα σας ειδοποιήσει εάν 

έχετε κάνει αυτή την επιλογή. 

mailto:info@masesoft.com
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5. Γεωμετρία 

 
Cross section → Πρόσθεση όλων των διατομών που θα χρησιμοποιηθούν στο σχεδιασμό του 
μοντέλου.  
 

 
 

 
 

 
 

Ο χρήστης μπορεί να 
χρησιμοποιήσει και το κουμπί των 
Cross-sections (Ctrl+J) 

mailto:info@masesoft.com
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6. Definition of a composite deck  

6.1. 1D Members 

Main → Structure → 1D member → select 1D member (Filter all) 
 

 

Από την εντολή ‘’Type of connections’’ → With standard composite action 

  

6.2. 1D Members 

Main → Structure → 2D member → Plates → Plate/ Composite deck/ Metal deck/ Ribbed Slab 

‘’Element type’’ → Composite deck 

‘’Element behaviour’’ → Flexible, Rigid or Semi-Rigid diaphragm  

‘’Profiled sheeting’’’→ Choose from the list or make one your own  

etc. Kingspan 60-V20-1.00 (multideck) 
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Το πιο κάτω μήνυμα προειδοποιεί ότι πρόκειται να δημιουργήσει αυτόματα ‘’Load cases’’ για την 
ώρα της σκυροδέτησης (wet concrete) αλλά και μετά που θα ωριμάσει (dry concrete - curing) το 
σκυρόδεμα μας. 
 

 

                                           
 
Παρατηρείται ότι στην αριστερή εικόνα το ‘’composite deck’’ τοποθετήθηκε παράλληλα με τον 
δευτερεύων οπλισμό, το οποίο δεν συνεφέρει θετικά στην κατασκευή. Το επιθυμητό είναι η 
τοποθέτηση του ‘’composite deck’’ να είναι παράλληλη με το κύριο οπλισμό. H μετακίνηση αυτή 
γίνεται από τα “Properties’’ → ‘’LCS angle 90 (deg)”. 
 
Η σύμμεικτη πλάκα (composite deck) με δοκάρια χάλυβα μοντελοποιείται χρησιμοποιώντας μια 
τυποποιημένη πλάκα με νευρώσεις πλάκας (ribs). Πρέπει να ρυθμιστεί μόνο ένας περιορισμένος 
αριθμός ιδιοτήτων, στην πλάκα και στις ιδιότητες της δέσμης, ώστε τα δομικά μέρη να 
συμπεριφέρονται ως σύνθετα υλικά και να επιτρέπουν τη χρήση των κατάλληλων ελέγχων. 
 
Για περισσότερες πληροφορίες όσον αφορά τα composite deck μπορείτε να επισκεφτείτε τους πιο 
κάτω συνδέσμους. 
 

• Definition of a composite deck 

 
 

mailto:info@masesoft.com
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7. Composite 

Main → Composite → Composite setup  
 
Οι έλεγχοι σύνθετου κώδικα (Composite code check) βασίζονται στην τεχνολογία «Open Checks» 
και στα έντυπα σχεδίασης της SCIA. Ωστόσο, για να αποφευχθεί η διπλή εισαγωγή ορισμένων 
από τα δεδομένα και να επωφεληθούν περισσότερο από το CAM (Composite Analysis Model), 
όλα τα δεδομένα που εισάγονται που απαιτούνται για σύνθετους ελέγχους έχουν συγκεντρωθεί 
στη σύνθετη υπηρεσία στο χαρακτηριστικό μέλος «Composite Beam Data» και στη σύνθεση 
«Composite». 
 
Αυτό το κεφάλαιο παρέχει λεπτομερείς πληροφορίες σχετικά με τις ρυθμίσεις που είναι διαθέσιμες 
στο «Composite setup» και στα «Composite Beam Data» που σχετίζονται με τους σύνθετους 
ελέγχους (composite checks). 
 
Από την εντολή ‘’Composite setup’’ μπορώ να τροποποιήσω τους οπλισμούς που προκαθορίζει  
το πρόγραμμα.   
 

 
 
 
Main → Composite → Composite setup → Shear connectors  

       → Slab reinforcement 
 
 
Οι ρυθμίσεις που σχετίζονται με το μοντέλο ανάλυσης (CAM) έχουν ήδη αναλυθεί στο 
προηγούμενο κεφάλαιο " Composite Analysis Model in SCIA Engineer ". Οι υπόλοιπες ρυθμίσεις 
σχετίζονται με τους σύνθετους ελέγχους (composite checks). Οι περισσότερες από αυτές 
καθορίζουν τις προεπιλεγμένες ρυθμίσεις που θα χρησιμοποιηθούν για σύνθετα μέλη χωρίς 
συγκεκριμένες ρυθμίσεις. Όλες οι ρυθμίσεις μπορούν να αντικατασταθούν με τα χαρακτηριστικά 
Composite Beam Data (δείτε το επόμενο κεφάλαιο " Composite Beam Data "). 
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Main → Composite → Composite setup → Load cases & stages  
 

 
 

• Composite Checks 

• Open Checks: Link with SCIA Design Forms  

mailto:info@masesoft.com
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https://help.scia.net/18.1/en/#pvt/open_checks_sdf/open_checks_link_with_scia_design_forms.htm%3FTocPath%3DOpen%2520Checks%253A%2520Link%2520with%2520SCIA%2520Design%2520Forms%7C_____0
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Για να φαίνεται το κτήριο όπως θα είναι στη πραγματικότητα (Structural model) πατώ:  
 

 
 

Input of 1D members 

• https://www.youtube.com/watch?v=39k0M9176ic&index=5&list=PL0OvQw2kgGq6RgBwr

Qj7cx0kCskBg5FCW 

Για να σπάσει η δοκός θα πρέπει ο χρήστης να επιλέξει τη δοκό και να πατήσει την εντολή 

“Break in defined points” και να επιλέξει τους κόμβους στο σημείο που επιθυμεί να σπάσει και 

μετά Esc  

 

mailto:info@masesoft.com
https://www.youtube.com/watch?v=39k0M9176ic&index=5&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW
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Όπως μπορεί κανείς να παρατηρήσει στην προηγούμενη εικόνα οι τεγίδες που 

τοποθετήθηκαν στη στέγη κατασκευαστικά είναι σωστά. Γραφικά για το μοντέλο, ο χρήστης 

μπορεί να τις «μετακινήσει». Από «Setting of UCS for active view» υπάρχουν 2 τρόποι, είτε 

από «According to entity LCS» είτε από «UCS manager» 
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Στη περίπτωση «According to entity LCS», ο χρήστης επιλέγει το στοιχείο στο οποίο επιθυμεί 

οι τεγίδες να ακολουθήσουν.   

 

Στη περίπτωση «UCS manager» για να μεταφερθεί το UCS κάτω.  
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8. Στηρίξεις  

➔ Για θεμελίωση άκρων των κολώνων / δοκών επιλέγω και βάζω πάκτωση   

➔ Για τους κόμβους: Structure → Model data → Support → In node  

 

 

 

 

Main → Structure → Model data → Hinge on beam (i.e change fix or/and fiz to free) 

Αυτό γίνεται συνήθως όταν υπάρχουν κάποιες δευτερεύουσες δοκοί οι οποίες κατά την γνώμη 

του Πολιτικού Μηχανικού δεν μεταφέρουν π.χ. ροπές κάμψης κτλ. 

 

Input of Supports 

 

• https://www.youtube.com/watch?v=EG8XWmtsp8g&index=8&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW  
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9. Έλεγχος Γεωμετρίας 

 

Main → Structure → Check structure data → Check → Continue → OK 

Αυτό γίνεται πάντα μετά από την σύνδεση των μελών μας (Connect Members/Nodes) για να δούμε 

τυχόν διπλές ονομασίες, ασύνδετα μέλη και γενικά προβλήματα του στατικού μας φορέα. 
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10. Load Panels 

10.1. Load to panel edges and beams  

Το μέλος 2D ενεργεί ως πλαίσιο φορτίου, δηλ. ανακατανέμει φορτία στις υποκείμενες δοκούς και 
τοίχους, αλλά δεν έχει δυσκαμψία. ένα μέλος με αυτή τη ρύθμιση δεν θα επηρεαστεί από το CAM 
 

Structure → Load Panels → Load to panel edges and beams  

-Layer → Load panel  

-Load transfer method → Tributary area  

-Max eccentricity of members = 0.2 m (Default) 

 
 

10.2. Plates 

Structure → Load panels → Load to panel edges & beams  
or 

→ 2D Members → Plates → Plate (Concrete) 
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Όποιες και αν είναι οι επιλογές μου μπορούν πολύ εύκολα να αλλάξουν μέσω του παραθύρου 
αριστερά ‘’Properties’’. 

 

Creating and Using Load Panels 

 

• https://www.youtube.com/watch?v=vRAWR_i5mBo&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=19 

 

Input of 2D members: plates, walls 

 

• https://www.youtube.com/watch?v=R8ocFcA6HwA&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=6 

 

 

Για άνεμο βάζω ‘’Load Panel’’ σε όλους τους τοίχους / πλάκες (3D WIND)  

 

➔ Το τοξάκι πρέπει να βλέπει προς τα έξω – Αν όχι → Double Click στο τοξάκι →Swap 

outer surface  

➔ Για οροφή αν βάλω ‘’2D Plate’’ (Properties → 3D WIND) 

➔ Με αυτό τον τρόπο βοηθώ το SCIA Engineer να δημιουργήσει αυτόματα όλες τις 

διευθύνσεις ανέμου που θα επηρεάσουν το κτίριο μου. 
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10.3. Load Cases  

 
Main → Load Cases  
(Selfweight, Dead, Dead Partitions, Dead Roof, Live, Live Roof, 3D wind)  
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Τα ‘’Load group’’ για 

τα ‘’Self weight’’ και 

για τα ‘’Dead loads’’ 

δημιουργούνται 

αυτόματα. 

 

Για τα ‘’Live loads’’ 

πρέπει ο χρήστης να 

επιλέξει πατώντας τις  

τελείες για να 

δημιουργήσει ένα νέο 

‘’Load group’’ με την 

κατηγορία που 

επιθυμεί π.χ.  

Cat A: Domestic 

δηλαδή κατοικίες.  

Eurocode 0, Annex 

A1, table A1.1. 
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Δεν έχουν οριστεί ακόμη τα σεισμικά ‘’Load cases’’, γιατί η κατασκευή δεν έχει φορτίσει με τα 

μόνιμα φορτία (Dead loads) και τα κινητά φορτία (Live loads) τα οποία θα δώσουν τις σεισμικές 

μάζες (Mass Groups / Combination of mass groups) και άρα τα σεισμικά ‘’Load cases’’. 

 

Creation of Load Groups and Cases 

 

• https://www.youtube.com/watch?v=CdtFbUKsMPA&index=13&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 

 

Creation of Load Combinations 

 

• https://www.youtube.com/watch?v=p6CH4Mini-

A&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW&index=14 
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10.4. Loads  

Loads → Dead → Surface load → On 2D member 

 

Οι φορτίσεις εισάγονται αναλόγως της κατασκευής μας. 

 

 

 

Loads → Live → Surface load → On 2D member  

Τα κινητά φορτία εισάγονται σύμφωνα με το παράρτημα της κάθε χώρας! ΑΝ επιθυμείτε μπορείτε 

να τα αυξήσετε. 

Στην Κύπρο: 

Πλάκες (βατές): 2 kN/m2, Πλάκες (Μη βατές): 0.4 kN/m2 

Κλιμακοστάσια: 3 kN/m2 

Πρόβολοι: 4 kN/m2 
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3D Wind Load Generator 

 

• https://www.youtube.com/watch?v=6JLwonXonWw&list=PL0OvQw2kgGq6RgBwrQj7cx

0kCskBg5FCW&index=16 

 

Input of Free Surface Loads 

 

• https://www.youtube.com/watch?v=7qkUG7B-

Jdc&index=17&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 

 

Creation of Basic Loads 

 

• https://www.youtube.com/watch?v=iSaQG7Lgl1w&index=15&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 
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11. Connect Members/nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes  

 

Πριν να γίνει η ένωση των κόμβων πρέπει να σιγουρευτείτε για τη γεωμετρία. Αν προκύψει 

οποιαδήποτε αλλαγή θα πρέπει να ξαναγίνει η σύνδεση των κόμβων. Επίσης, αν ο χρήστης 

πρόκειται να μετακινήσει κάποιο κόμβο ή μέλος πρέπει να τα αποσυνδέσει (Disconnect 

members/nodes) γιατί θα μετακινηθούν και τα υπόλοιπα μέλη που είναι συνδεδεμένα μεταξύ τους. 
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12. Mesh generation   

 Πρέπει να γίνει αμέσως μετά που θα φορτίσω την κατασκευή μου, για να μεταφερθούν τα 

φορτία σωστά και να μπορέσουν μετά να δημιουργηθούν οι σεισμικές μάζες. 

 

Intro to Mesh Setup & Generation 

 

• https://www.youtube.com/watch?v=CBs068SBH1Y&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=20 

 

 
13. Mass Groups  

Main → Dynamics → Mass groups (Selfweight, Dead, Live, etc.) 
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14. Combination of Mass Groups  

 

Main → Dynamics → Combination of mass groups → Add All → OK 

➔ MG3 = Live Load → Coeff.= 0.3 (70% απομείωση)  

➔ For ‘’Dead’’ and ‘’Live’’ loads below surface (also with ground floor) are NOT added to 

the ‘’Combination of mass groups’’ because masses below ground surface are NOT 

calculated. 

➔ For ‘’Live’’ loads for seismic combination above ground (0+) → Used Coeff. = 0.3  

➔ Code: ΨΕi = φ x ψ2i = 0.3 (Residential φ = 1, ψ2 = 0.3) - Table A1.1 + A1.2(B) (CYS) 

 

 

 

Αυτό γίνεται για όλες τις μάζες εκτός από τα ‘’Free loads’’ τα οποία δεν συμπεριλαμβάνονται εδώ. 
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15. Seismic X 

 

Main → Load cases → New → Seismic X 
 
Δημιουργήστε μια νέα ομάδα φορτίων LG3 (Together And Seismic)  

Main → Dynamic → Seismicity → Check the direction X 

 

16. Seismic spectrums  

Libraries  → Loads → Seismic spectrums (q-factor i.e. for Steel) 
➔ Type drawing → Period 

➔ Info short → Eurocode 

 

Edit → Code parameters  
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➔ Code parameters   

➔ Coeff. accel. ag (AgR)= AgR * γi= 0.25 * 1= 0.25 

➔ ag – design acceleration= 0.25 * 9.81= 2.453 m/s2 

➔ q factor= 2.5 

➔ beta= 0.20 

➔ Subsoil= C 

➔ Spectrum type= Type 1 

➔ Direction= Horizontal  

 

➔ To γi τροποποιείται ανάλογα σε ποια κατηγορία σπουδαιότητας είναι το κτήριο.  

 

Κατηγορίες Σπουδαιότητας (γi) 

Κατηγ. Ι (Φάρμες) 0.8 

Κατηγ. ΙΙ (Κατοικίες) 1.0 

Κατηγ. ΙΙΙ (Σχολεία κλπ) 1.2 

Κατηγ. ΙV (Νοσοκομεία κλπ) 1.4 
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Κατά τον Ευρωκώδικα 8 (σε κτίρια) η κατακόρυφη συνιστώσα χρειάζεται να λαμβάνεται υπ' όψη 
εάν η μέγιστη κατακόρυφη επιτάχυνση avg, είναι μεγαλύτερη από 0,25g δηλαδή, στη Ζώνη  
Επικινδυνότητας 2 = 0.20 (μόνο για την γi = ΙV), καθώς και στην Ζώνη  Επικινδυνότητας 3 = 0.25 
μόνο για τις κατηγορίες σπουδαιότητας (γi = III και ΙV), αλλά και πάλι μόνο στις ακόλουθες 
περιπτώσεις: 
 
– για (σχεδόν) οριζόντια μέλη με άνοιγμα τουλάχιστον 20m 
– για (σχεδόν) οριζόντιους προβόλους με άνοιγμα μεγαλύτερο από 5m 
– για (σχεδόν) οριζόντια προεντεταμένα μέλη 
– για δοκούς που στηρίζουν φυτευτά υποστυλώματα 
– σε κτίρια με σεισμική μόνωση. 
 
Για την παρούσα μελέτη ισχύει avg = AgR*γi*0.9 = 0.9*1*0.25g = 0.225g < 0.25g.  
 
Άρα δεν θα ληφθεί υπόψη η κατακόρυφη συνιστώσα του σεισμού στη μελέτη της υπ' όψη 
κατασκευής θεωρώντας ότι η επιρροή της καλύπτεται από τους συντελεστές ασφαλείας γg=1,35 
και γq=1,50 στον συνδυασμό βασικών δράσεων χωρίς σεισμό, και από τα υφιστάμενα περιθώρια 
αξονικής αντοχής των κατακόρυφων στοιχείων.  
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17. Load  - CQC 

➔ Load cases → SEISMIC X → Modal Superposition → Type of superposition → CQC 
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➔ Edit  

➔ Frequency 10000 (έλεγχος σε ευρύ φάσμα συχνοτήτων) 

➔  Damping (ξ) 3% - 5% (Concrete, Steel, Timber) 
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18. Combinations  

➔ List of load cases -> Combinations → Insert → Add ( Selfweight / Dead / Live) 

➔ Name – SLS 

➔ Type – EN-SLS characteristic → Yes → OK 

 

➔ ULS Set B, ULS Set C with SW, DL, LL loads and with Wind load cases 

➔ Name – ULS Set B 

➔ Type – EN-ULS Set B → Yes → OK 

 

➔ Name – ULS Set C 

➔ Type – EN-ULS Set C → Yes → OK 

 

➔ Name – Seismic X (0.3Y) Απομειώνω τον σεισμό στο Υ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 

 

➔ Name – Seismic Y (0.3X) Απομειώνω τον σεισμό στο Χ κατά 70% 

➔ Type – EN-Seismic → Yes → OK 
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Τα ‘’Load cases’’ για τον 

άνεμο δημιουργούνται 

αυτόματα και ο χρήστης 

πρέπει να τα εισάγει εδώ, 

δηλαδή στον συνδυασμό 

‘’ULS’’ γιατί ο κανονισμός μας 

επιτρέπει να ΜΗΝ έχουμε δυο 

(2) τυχηματικές δράσεις να 

εισάγονται μαζί στην ανάλυση 

μας (Άνεμος και Σεισμός μαζί). 

Αυτό είναι εφικτό γιατί είναι 

αρκετά σπάνιο γεγονός να 

συμβούν ταυτόχρονα. 

 

To SCIA Engineer δημιουργεί 

αυτόματα όλες τις διευθύνσεις 

ανέμου που θα επηρεάσουν 

το κτίριο μου οι οποίες θα 

φαίνονται στην δεξιά λίστα 

‘’List of load cases’’. 
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• Combinations containing seismic load cases 
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19. Result classes  

➔ Main → Load case → Result classes  

➔ SLS 

➔ ULS 

➔ SEISMIC 

➔ GEO (ULS Set C) 

 

 

 

Χρειάζεται προσοχή όταν αναλύεται μια κατασκευή με δυναμική φόρτιση στο SCIA Engineer έτσι 

η MASES SOFTWARE προτείνει να δείτε την παρακάτω ιστοσελίδα της SCIA. 

 

• Dynamic analysis troubleshooting  
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20. 3D WIND 

 

Τοποθετώ ‘’Load Panel’’ σε όλους τους τοίχους / πλάκες (3D WIND)  

 

→ Το τοξάκι πρέπει να βλέπει προς τα έξω – Αν όχι → Swap outer surface  

→ Για οροφή αν βάλω 2D plate (Properties → 3D WIND) 

→ Με αυτό τον τρόπο το SCIA Engineer δημιουργεί αυτόματα όλες τις διευθύνσεις ανέμου 

που θα επηρεάσουν το κτίριο μου. Τον άνεμο μπορούμε να τον δημιουργήσουμε στο 

πρόγραμμα πριν ή και μετά το βήμα 10 (βλέπε σελίδα 30) 

 

20.1. 3D Wind to Load Panels 

 
Main → Load Panels → Load to panel edges 
 

Layer → Load Panels  

Load transfer direction → X (LCS panel)  

Load transfer method → Tributary area 

 

Γίνεται ένωση από κόμβο σε κόμβο και δημιουργείται το ‘’Load Panel’’. ΠΡΟΣΟΧΗ το τοξάκι 

πρέπει να δείχνει πάντοτε έξω από την κατασκευή. Αν όχι, πατείστε στο τοξάκι και από την εντολή 

swap outer surface πατείστε . 
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20.2. Load → 3D Wind Generation  

 
Main → Load → 3D Wind Generation → Add Load Cases → OK 
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20.3. Load Case, Combinations → Load Cases 

 
Main → Load Case, Combinations → Load Cases  
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20.4. Load Cases, Combinations → Combinations  

Main → Load Cases, Combinations → Combinations → ULS Set B  
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21. Calculation 

 

21.1. Calculation  

Main → Calculation/ Mesh → Calculation  

 

 

Running an Analysis, Check Structure Data and Connect Nodes/Members 

 

• https://www.youtube.com/watch?v=aq1S51ebBtw&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=21 

 

 

 

 

 

 

 

 

 

 

  

mailto:info@masesoft.com
https://www.youtube.com/watch?v=aq1S51ebBtw&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW&index=21
https://www.youtube.com/watch?v=aq1S51ebBtw&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW&index=21


57 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

21.2. Mesh setup 

 

Main → Calculation / Mesh → Mesh setup  

 

Δείχνει σε πόσα μέρη θα γίνει η ανάλυση των πεπερασμένων στοιχείων. 

 

Αν ο χρήστης επιθυμεί το πρόγραμμα να το κάνει αυτόματα τότε: Advanced mesh settings → 
Automatic .  Πρέπει όμως να επιλέξει ‘’Load cases’’. 

 

Πρέπει όμως να επιλέξω ‘’Load cases’’. 

 

• https://resources.scia.net/en/articles/analysis/15_3_automatic_mesh_refinement_improv

ement.htm 

 

Automatic mesh refinement in SCIA Engineer 16 

 

• https://www.youtube.com/watch?v=P5RoDSnMGy0 

 

 

 

➔ Average number of tiles of 1D element → 4  

➔ Average size of 2D element/curved element → 0.25 (0.20 - 0.30) 

 

Το μέγεθος του πλέγματος (mesh) του επιφανειακού πεπερασμένου στοιχείου (2D member) 
εξαρτάται από το πάχος του και πόσο πυκνό το θέλει ο μελετητής. 
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21.3. Solver setup 

 

Main → Calculation/ Mesh → Solver setup 

- Number of eigenmodes → 30 

 

Το IRS χρησιμοποιείται όταν το μοντέλο είναι τουλάχιστον 2 ορόφων και άνω. 

Το IRS μου προτείνει τον ακριβή αριθμό ιδιομορφών (eigenmodes) !!! 

 

• http://masesoft.com/seismic-design.html 

 

 

 

 

Σε περίπτωση που ο χρήστης αντιμετωπίζει λάθη στο μοντέλο, υπάρχουν τα βοηθήματα 

(help.scia.net): 

 

• IRS: Too many eigen values requested / Non-associated R-node detected 

 

• Issue: incorrect sum of masses 

 

• Issue: total base shear is not the sum of modal values 
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21.4. Calculation protocol 

Main → Results → Calculation protocol → Type: Eigen frequency → Preview 

 

• http://masesoft.com/seismic-design.html 

 

 

 

 
 

Πρώτα γίνεται μια φασματική ανάλυση ούτως ώστε ο χρήστης να μπορεί να δει την συμπεριφορά 

του κτηρίου και εφόσον είναι ικανοποιημένος τότε μπορεί να προχωρήσει σε γραμμική και 

δυναμική ανάλυση (Linear Analysis) για έλεγχο πλέον του στατικού φορέα.  

• Validation of modal analysis: mode shapes 

 

• Validation of modal analysis: relative modal masses 
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22. Results 

 

22.1. Linear Analysis 

Run LINEAR Analysis ONLY (Συμπεριλαμβάνει και τον σεισμό!) 
 
Main → Results  

 

22.2. Displacement of nodes  

 

 

Ο χρήστης μπορεί να επιλέξει κάποιους κόμβους (nodes) της επιλογής του για να παρατηρήσει 

την μετατόπιση τους (Displacement), αλλιώς το πρόγραμμα θα δώσει αποτελέσματα 

μετατοπίσεων όλων των κόμβων του κτιρίου. 
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22.3. 3D displacement 

Main →Results → 3D displacement  

 

 

 

Παρατηρείται ότι η μεγαλύτερη μετακίνηση είναι στο κέντρο της πλάκας του κτηρίου, με μετακίνηση 

που κυμαίνεται από 4 έως 4.5 χιλιοστά (mm)! Αν ο χρήστης επιθυμεί μικρότερη μετακίνηση του 

δίνεται η δυνατότητα να αλλάξει τις διαστάσεις των δευτερευουσών δοκών σε μεγαλύτερες 

διαστάσεις.  

Με την εντολή Wireframe, παρουσιάζεται το κτήριο σε γραμμική μορφή. 

 

Main → Results → 3D displacement → Wireframe  
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22.4. 3D stress 
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23. Supports 

23.1. Reactions 

Main → Results → Supports → Reactions 

 

 

Με την εντολή ‘’Type of Loads’’  γίνεται επιλογή ‘’Load cases’’, αν όμως εμφανίζεται αστεράκι (*) 

δίπλα από τα ‘’Load cases’’ (δλδ, Load cases*) τότε το πρόγραμμα δεν έχει τρέξει σε ‘’Linear 

Analysis’’ αλλά μόνο σε ‘’Modal Analysis’’ (Μόνο φασματική).  

 

• https://www.youtube.com/watch?v=MAL0ia01zIY&index=22&list=PL0OvQw2kgGq6RgB

wrQj7cx0kCskBg5FCW 

 

23.2. Beams 

23.2.1. Internal forces of beam 

Main → Results → Beams → Internal forces of beam  

(It includes Columns and Beams) 
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Δίνεται στο χρήστη η δυνατότητα για επιλογή κάποιων στοιχείων δοκών ή/και κολώνων. Στην 

επιλογή ‘’Selection’’ → ‘’Current’’ αναλύει τα επιλεγόμενα στοιχεία αλλιώς δίνεται η επιλογή ‘’All’’ 

όπου δίνει τις εσωτερικές δυνάμεις των στοιχείων. Επίσης, στην επιλογή ‘’Extreme’’ αν επιλεχθεί 

το ‘’Global’’ εμφανίζονται τα δυσμενέστερα αποτελέσματα.  

 

                            

 

 

 

23.2.2.  Deformations of beam 

Main → Results → Beams → Deformations of beam  

 

 

 

 

Στη περίπτωση αυτή, επιλέχθηκαν οι κολώνες στον πάνω όροφο (κατ’ επιλογή) ), έτσι 

παρατηρείται η παραμόρφωση των επιλεγμένων στοιχείων.  
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Στην περίπτωση αυτή, ‘’Global’’ εμφανίζονται μόνο οι δυσμενέστερες μετατοπίσεις (SLS) όπως 
φαίνεται πιο κάτω. 
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23.3. Member Stress  

 
Main → Results → Beams → Member Stress  
 
Εδώ ‘’Selection’’ → ‘’All’’ φαίνεται η ολική συμπεριφορά του κτιρίου, ενώ στη δεύτερη εικόνα 
παρουσιάζονται τα αποτελέσματα των στοιχείων που επιλέξαμε να αναλυθούν.  
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24. Acceleration of nodes  

  
Main → Results → Dynamics → Acceleration of nodes  
 
 

 

 

 

Type of Loads → Mass combinations  

Mass combinations – για παράδειγμα  CM 1/4 – 4.66, παρατηρείται στο συγκεκριμένο κόμβο 

(node) τι συμβαίνει - πως αντιδρά.  
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25.  2D members  

25.1. Displacement of nodes 

 
Main →Results → 2D members → Displacement of nodes 
 

 

 

25.2.  Internal Forces  

 

Main → Results → 2D members → Internal forces 

 

 

Η πλάκα του πιο πάνω μοντέλου έγινε με οπλισμένο σκυρόδεμα (2D member) - ‘’Load panel’’ 

που απλά μεταφέρει φορτία στον φορέα και δεν έχει δυσκαμψία. Αν ο χρήστης επιθυμεί η 

πλάκα να είναι από Ο/Σ θα πρέπει να συνυπολογιστεί επιπλέον στο συνολικό βάρος με 

επιπρόσθετα φορτία των μόνιμων π.χ. βάρος 10cm πλάκας= 2,5kN/m2 + 3 kN/m2 (μόνιμα). 

 

mailto:info@masesoft.com


69 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

25.3. Stresses / Strain 

Main → Results → 2D members → Stresses / Strain 
 

 

 

 

26. Bill of material  

Main → Results → Bill of material (Estimation of quantities) 
 

 

 

Στη περίπτωση αυτή υπολογίζεται το βάρος του κάθε υλικού σε όλη τη κατασκευή.  

Αν θα έχει πλάκα από Ο/Σ θα πρέπει ΠΡΩΤΑ να γίνει η ανάλυση ή το ‘’Mesh generation’’. 
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27. Calculation protocol 
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Intro to Results on Supports 

 

• https://www.youtube.com/watch?v=MAL0ia01zIY&list=PL0OvQw2kgGq6RgBwrQj7cx0

kCskBg5FCW&index=22 

 

Results on 1D Members 

 

• https://www.youtube.com/watch?v=f5jCcqoIc1s&list=PL0OvQw2kgGq6RgBwrQj7cx0k

CskBg5FCW&index=23 

 

Results on 2D Members 

 

• https://www.youtube.com/watch?v=BMDFyMhXgck&list=PL0OvQw2kgGq6RgBwrQj7c

x0kCskBg5FCW&index=24 

 

3D Results 

 

• https://www.youtube.com/watch?v=yaaNZhCITnA&index=25&list=PL0OvQw2kgGq6Rg

BwrQj7cx0kCskBg5FCW 

 

Intro to Story Results 

 

• https://www.youtube.com/watch?v=vSTN9OyqS-

Q&index=26&list=PL0OvQw2kgGq6RgBwrQj7cx0kCskBg5FCW 
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28. Steel design 

 

28.1. Steel Connections 

 

• http://masesoft.com/steel-connections.html 

• https://www.youtube.com/watch?v=xNSLjSIbs0E 

 

28.2. ULS Checks  

 
Main → steel → Beams → ULS Checks 
 

 
 

 
 

Παρατηρείται ότι η δυσμενέστερη δοκός είναι η Β12 με Unit Check (UC) = 0.39 

  

mailto:info@masesoft.com
http://masesoft.com/steel-connections.html
https://www.youtube.com/watch?v=xNSLjSIbs0E


73 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

28.3. SLS Checks Relative Deformation  

Main→ Steel → Beams → SLS Checks Relative Deformation  
 

 
 

 

 
 

 

Έλεγχοι βέλους κάμψης SLS – Characteristic: 

 

→ Beams = L/250 

→ Cantilevers = L/180 

→ Beams (Bricks) = L/360 
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28.4. Steel slenderness 

 
Main → Steel → Steel slenderness  
 

 
 

 

28.5. Lateral – torsional buckling settings  

 

In case of high Unity, Section and Stability checks you may need to add LTB restraints and Member 

buckling data for steel members 

 

 
 

Θα τοποθετηθούν σημεία σε κάθε 0,111 μέτρα καθ’ ύψος της προεπιλεγμένης κολώνας, ούτως 

ώστε να αποφευχθεί ο στρεπτοκαμπτικός λυγισμός.  
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29. Check of Connections 

 

29.1. Structural joints → Frame strong – axis 

Main →Steel → Connection → Structural joints → Frame strong - axis   

 
 

 

Με την εντολή ‘’Frame strong – axis’’ επιλέγεται κόμβος - πλαίσιο στον ισχυρό άξονα και το 

πρόγραμμα ονομάζει το κόμβο με όνομα π. χ Conn2 N1932(Connection). Στη περίπτωση που 

επιθυμεί ο χρήστης «bottom haunch» δηλαδή να σχηματιστεί γωνιά στηριζόμενη στη κολώνα, 

το επιτυγχάνει με την εντολή ‘’Bottom haunch’’ για τροποποίηση ύψους και μήκους του 

haunch.  

Με την εντολή ‘’Bolts’’ μπορεί εύκολα να επιλέξει τον τύπο και το είδος της βίδας που θα 

χρησιμοποιήσει.  

 

• https://www.youtube.com/watch?v=k14fBDgQ06Q 

 

 

29.2. Structural joints → Frame weak - axis  
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Main → Steel → Connection → Structural joints → Frame weak - axis  

 

 
 

 

29.3. Structural joints → Grid pinned   

Main → Steel → Connection → Structural joints → Grid pinned   

 

• https://www.youtube.com/watch?v=zDVOrqVU0pw 

• grid pinned connection 

 
 

 
 

Bolts →  Γίνεται η επεξεργασία του τύπου των βιδών που θα τοποθετηθούν, ο αριθμός στηλών 

των βιδών, η φλάντζα κλπ.  

 

 

29.4. Structural joints → Overall check  
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Main → Steel → Connection → Structural joints → Overall check  

 

Με την εντολή ‘’Overall Check’’ όπου υπάρχει σύνδεση κόμβων ελέγχεται αν είναι ΟΚ! 
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30. Foundation design 

 
Το SCIA Engineer διαθέτει ενσωματωμένο εργαλείο για πλήρη έλεγχο θεμελιώσεων σύμφωνα 
με τον EC7. 
 

30.1. Μεμονωμένα Πέδιλα  

30.1.1. Supports 

Remove supports 

Main → Structure → Model data → Support → surface (el. foundation) 

 
 

30.1.2. Functionality  

Από Βήμα 2.1: Functionality → Pad Foundation Checks →  
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30.1.3. Subsoil, Foundation → Pad Foundation  

Libraries → Subsoil, Foundation → Pad Foundation  

Libraries → Load → Seismic spectrums (q-factor for concrete) 

 

Από ‘’Properties’’ τροποποιείτε την εντολή ‘’Type’’ από ‘’Standard’’ σε ‘’Pad Foundation’’ και 

εμφανίζεται πέδιλο. Αφού εφαρμοστεί σε όλες τις στηρίξεις και υπάρχουν παντού πέδιλα, ο 

χρήστης μπορεί να τα επεξεργαστεί πατώντας διπλό κλικ σε ένα πέδιλο, στη επιλογή ‘’Pad 

Foundation’’. 

     

 
 

 

Υπάρχει επιλογή για αλλαγή των παραμέτρων του πέδιλού (π.χ. μήκος, πλάτος, ύψος).  

Αυτό εξαρτάται και από το γεγονός αν το πέδιλο σου είναι έκκεντρο ή όχι.  
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30.1.4. Subsoil, Foundation  

Libraries → Subsoil, Foundation → Change Description, Parameters, Type etc 
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Για την γεωμετρία θα χρειαστεί να ενεργοποιήσετε: 

 

➔ Snap mode            

➔ View → Set view parameters > Set view parameters for all  

Ακόμη και αν εισάγατε αρχείο CAD στον κάνναβο σας προτιμότερο θα ήταν να δημιουργήσετε και 
κάνναβο ‘’3D line grid’’. 
 
Αφου ολοκληρωθούν τα βήματα με την γεωμετρία των πεδίλων, γίνεται ανάλυση. 

 

30.1.5. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 

30.1.6. Check structure data 

Main → Structure → Check structure data 

 
30.1.7. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  

Analysis → Batch analysis (Linear, Modal, Stability) 

 

Η ανάλυση θα διαστασιολογήσει όλα τα πέδιλα και θα δείξει το δυσμενέστερο πέδιλο, επομένως 

τα υπόλοιπα πέδιλα χρειάζονται μικρότερες διαστάσεις. 

Αφού είναι γνωστό πιο πέδιλο είναι το δυσμενέστερο, ακολουθούνται τα βήματα για αλλαγή των 

παραμέτρων του (π. χ μήκος, πλάτος, ύψος κλπ.) και ξανά ανάλυση του προγράμματος. (Βήμα 

31.6) 

 

30.1.8. Geotechnics  

Main → Geotechnics → Foundation Pad  Change Mx, My etc  
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Geotechnics → Foundation Pad → Refresh → Change to Current → See Result table ! 

 

Προσοχή !! Κάθε φορά που τροποποιούνται οι διαστάσεις του πεδίλου, καλό είναι να γίνεται 

ξανά ανάλυση του μοντέλου.  

 

• https://www.youtube.com/watch?v=g63LDMqV3X8 

 

• https://www.youtube.com/watch?v=5lGQQrLPVAY 

 

• https://www.youtube.com/watch?v=cpYcN1dOgD4 

 
30.2. Results 

 

Main → Results 

 

Engineering Report for steel results 

Engineering Report for concrete results 

Engineering Report for Composite results 
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31. Μεμονωμένα Πέδιλα με Χρήση Πεδιλοδοκών 

Εφαρμόζεται η ίδια διαδικασία όπως στα μεμονωμένα πέδιλα αλλά τώρα με πρόσθεση 

συνδετήριων πεδιλοδοκών.  Για την ένωση των πεδίλων μεταξύ τους δημιουργούνται συνδετήριοι 

πέδιλό-δοκοί.  

 
31.1. Functionality  

Από Βήμα 2.1: Functionality → Pad Foundation Checks →  
 

31.2. Beam 

Main → Structure → 1D member → Beam 

 

Main → Structure → Model data → Property Modifiers 1D  (0.5) 

For 1D members below ground (0 <) change ‘’Mass factor’’ to 0*. 

 

Main → Structure → Model data → Property Modifiers 2D (0.5) 

For 2D members below ground (0<) change ‘’Mass factor’’ to 0*. 

   

* ‘’Mass factor’’ has to be zero (0) because foundations and basements have no movement 

because according to codes they are non-sway members. 

 

 
 

mailto:info@masesoft.com


85 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

 
 
 

31.3. Support  

Main → Structure → Model data → Support → Line on beam 

 

Type → Foundation strip  

Width b [m] → Edit 

Hight h [m] → Edit 
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31.4. Seismic spectrums  

Main → Libraries → Load → Seismic spectrums (q-factor for concrete) 
 

31.5. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 

31.6. Check structure data 

Main → Structure → Check structure data 

 
31.7. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  
Analysis → Batch analysis (Linear, Modal, Stability) 

 
 
 
 

 

mailto:info@masesoft.com


87 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 

31.8. Combinations → ULS Set C 

Main →Load Case, Combination → Combinations → ULS Set C 
 

 
 
 
 

Μέσα από τον Ευρωκώδικα 8, το ελάχιστο πλάτος για συνδετήριους πεδιλοδοκούς είναι 
bw,min=0.25m ενώ το ελάχιστος ύψος είναι hw,min = 0.50m. Στο μοντέλο ανάλυσης που αναλύεται 
στο πρόγραμμα είναι bw = 0,3 m και hw = 0,50 m.  
 

 

 
 
5.8.2 Tie-beams and foundation beams (Συνδετήριες μεμονωμένοι πεδιλοδοκοί) 
 
(3) Tie-beams and foundation beams should have a cross-sectional width of at least 
bw,min and a cross-sectional depth of at least hw,min . 
 
NOTE The values ascribed to bw,min and hw,min for use in a country may be found in its National Annex to 
this document. The recommended values are: bw,min = 0,25 m and hw,min = 0,4 m for buildings with up to 
three storeys, or hw,min = 0,5 m for those with four storeys or more above the basement.  
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31.9. Έλεγχος δοκών θεμελίωσης 

 
31.9.1. Reinforcement design  

Main → Concrete → Reinforcement design → 1D member → Slenderness  

 

 
 
 

31.9.2. 1D member → Reinforcement design  

 
Main → Concrete → Reinforcement design → 1D member → Reinforcement design  
 
Χωρίς να οπλιστεί η πεδιλοδοκός, εμφανίζεται ο απαιτούμενος θεωρητικός οπλισμός.  
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31.9.3. Reinforcement Check (ULS + SLS)  

 
Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Internal forces   
 
Εφόσον θέλετε να οπλίσετε τις πεδιλοδοκούς, γίνεται ο απαιτούμενος έλεγχος των οπλισμών σε 
αυτές.  
 

 
 
 
 

31.9.4. Reinforcement Check (ULS + SLS) → Slenderness 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Slenderness 
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31.9.5. Reinforcement Check (ULS + SLS) → Stiffnesses 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Stiffnesses 
 

 
 
 

31.9.6. Reinforcement Check (ULS + SLS) →Capacity – response (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Capacity – response 
(ULS) 
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31.9.7. Reinforcement Check (ULS + SLS) → Capacity – diagram (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Capacity – diagram 
(ULS) 
 

 
 
Με την εντολή Output → Detailed δίνεται η επιλογή μέσω του ‘’Preview’’ να δεί ο χρήστης το 
διάγραμμα αλληλεπίδρασης (Interaction diagram). 
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31.9.8. Reinforcement Check (ULS + SLS) → Shear + Torsion (ULS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Shear + Torsion 
(ULS) 
 

 
 
 
 

31.9.9. Reinforcement Check (ULS + SLS) →Stress Limitation (SLS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Stress Limitation 
(SLS)  
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31.9.10. Reinforcement Check (ULS + SLS) → Deflections (SLS) 

Main → Concrete → Reinforcement Check (ULS + SLS) → 1D member → Deflections (SLS) 
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31.10. Results 

31.10.1. Beams  

Main → Results → Beams → Internal forces on beam strip (√) 

 

31.10.2. 2D results 

Main → Results → Tools 2D results → Integration strip (Strip foundation)      

 

31.10.3. Member design 

Main → Concrete → 2D member → Member design → Member design ULS  

                                                                       Properties → Use scale isolines 

 

31.10.4. Reinforcement design 

Main → Concrete → Reinforcement design → 2D members → Reinforcement design (ULS) 

 

31.11. Engineering Report for steel results (Βλέπε Κεφάλαιο 34) 

31.12. Engineering Report for concrete results (Βλέπε Κεφάλαιο 34) 
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32. ΓΕΝΙΚΗ ΚΟΙΤΟΣΤΡΩΣΗ 

 

Η θεμελίωση με γενική κοιτόστρωση εφαρμόζεται κυρίως όταν το έδαφος δεν είναι πολύ 

ανθεκτικό - ασταθές έδαφος. Η λειτουργία της κοιτόστρωσης μοιάζει με τη λειτουργία μίας 

σχάρας πεδιλοδοκών. 

Στη γενική κοιτόστρωση οι ισχυρότερες τάσεις που δημιουργούνται είναι στην περιοχή των 

υποστυλωμάτων και οι ασθενέστερες τάσεις στις ενδιάμεσες περιοχές. Όταν υπάρχουν δοκοί 

ενίσχυσης, τότε οι τάσεις στο έδαφος έχουν μικρότερη απόκλιση μεταξύ των περιοχών των 

υποστυλωμάτων και των ενδιάμεσων περιοχών της κοιτόστρωσης. 

 

 

32.1. 2D Members → Plates  

 

Main → Structure → 2D Members → Plates → Plate (Concrete) 
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32.2. Support  

 

Main → Structure → Model data → Support → Surface (el. Foundation) 
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32.3. Reinforcement design  

Main → Concrete → Reinforcement design → 1D member → Reinforcement design  
 

 
 
 

32.4. Connect members / nodes  

Main → Structure → Model data → Connect members / nodes → Check  → Yes 
 
 

32.5. Calculation/ Mesh  

Main → Calculation/ Mesh → Calculation  
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33. ENGINEERING REPORT 

 
33.1. Engineering report 

Main → Engineering report 
 

Μέσω του Engineering Report εισάγονται όλα τα δεδομένα που 
σχετίζονται με τη μελέτη, επεξηγούνται οι λεπτομέρειες της μελέτης 
που κυμαίνονται από προσδιορισμό των δεδομένων της μελέτης στα 
στατικά αποτελέσματα της ανάλυσης, εισάγονται όλοι οι έλεγχοι 
σχεδιασμού του κτηρίου αλλά και τα σχέδια μελέτης που μπορεί 
εύκολα τόσο ο μελετητής όσο και η ομάδα αποπεράτωσης του έργου 
να τα αντιληφθεί.  
 
Επιπλέον, εύκολα μπορούν να ομαδοποιούνται δεδομένα της 
μελέτης και να εισάγονται εικόνες που αντιστοιχούν στα δεδομένα 
αυτά.  
 
Με την εντολή ‘’Engineering Report’’ ανοίγει παράθυρο στο οποίο 
με την εντολή ‘’New’’, μεταφέρεται στο report για αν το 
επεξεργαστούμε.    
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Διπλό κλίκ για να ανοίξει το 
παράθυρο του report και να το 
επεξεργαστούμε.   
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Main → Engineering report → Insert  
 

 
 
 
Στα αριστερά του παραθύρου εμφανίζονται όλες οι επιλογές που παρέχονται από το πρόγραμμα 
ούτως ώστε να εισαχθούν ότι θεωρείται από τον Μηχανικό απαραίτητο και σημαντικό για το report.  
Πιο κάτω φαίνονται κάποιες από τις επιλογές και πως χρησιμοποιούνται.  
 
Special items → Head and Footer  
  → Table of Contents  
  → Page Break 
  → Chapter → Properties → General 
 
Libraries →Material  
    → cross section 

   → Subsoils 
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Από εντολή ‘’Regenerate’’, και με τη χρήση του προγράμματος Scia Engineer, δεξί κλικ εμφανίζεται 
το πιο κάτω. 
Με την εντολή ‘’Live Picture in scale into Engineering report’’, προστίθεται η εικόνα του μοντέλου 
στο ‘’Engineering report’’.  
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33.2. Nodes, Member, 2D member 

 
Main → Engineering report → Structure 
 
Για να ενταχθούν τα χαρακτηριστικά των μελών, κόμβων κ.λ π (Nodes, Member, 2D member 
etc) στο ‘’Engineering report’’, επιλέγουμε την εντολή ‘’Structure’’  → Nodes 
                           → Member  
                           → 2D Member  
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33.3. Loads  

 
Main → ’’Engineering report’’ → ‘’Sets’’ προθέτονται τα ‘’Load Cases’’ στο engineering report.  
Για να εμφανίζεται εικόνα των ‘’Load Cases’’, πηγαίνουμε στο πρόγραμμα ‘’Main → Load’’ . 
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33.4. Results  

 
Για να προστεθούν τα αποτελέσματα του μοντέλου από το πρόγραμμα SCIA Engineer, 
ακολουθούνται τα παρακάτω βήματα.  
 
 
Main →Engineering Report → Report Template → System 
templates → 1D Internal forces 
 
Με την επιλογή ‘’1D Internal forces’’, παρουσιάζονται οι φορτίσεις 
(αξονικές, ροπές) της κατασκευής. 
 
Στις πιο κάνω εικόνες αναλύονται τα αξονικά φορτία της 
κατασκευή, οι ροπές στον x – άξονα, ροπές στον y- άξονα, ροπές 
στον z- άξονα.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 

mailto:info@masesoft.com


105 
 

Official Partner of SCIA in Cyprus 
 

Franklin Roosevelt 193, 3045, Limassol, Cyprus 

Tel: +357 25251718, Mob: +357 97614727 

Email: info@masesoft.com 
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Περισσότερες πληροφορίες όσον αφορά το Engineering Report μπορείτε να επισκεφτείτε τους 
πιο κάτω συνδέσμους.  
 

• SCIA ENGINEER: ENGINEERING REPORT TEMPLATES 

• Engineering Report - Τεύχος Υπολογισμών 

• Engineering Report 
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